1. About Event Wizard

Welcome to Event Wizard
We developed this tool in response to demand from Oracle Projects users for a user
friendly and robust spreadsheet tool to load Revenue and Billing Events into Oracle
Projects module.
Event Wizard is a VBA program embedded in a Microsoft Excel workbook. It is a close
cousin to our other ‘Wizard’ products and shares the same look and feel.
Features
All options are available on a ribbon/toolbar.
Double-clicking in the spreadsheet loads the Event form for data-entry. The data-entry
form is optional; you can also simply type, import, or paste the values directly into the
spreadsheet.
You can choose to upload Events one at a time, to upload a range of events, or your
entire worksheet.
The program is flexible about the spreadsheet layout. You can move, delete, or hide
unwanted columns. You can also have multiple sheets or even sheets in other
workbooks.
A download function is available to extract existing events.
information (within the Wizard) and reload it into Oracle.

You can update the

The spreadsheet contains a status column, enabling you to accurately track and correct
your records as they interface into Oracle HRMS.
This program has been developed on R11i but has been back-ported to R11.0.3 (which
uses ODBC connection technology). It is also supported on E-Business Suite 11.5.10
onwards (i.e. 11.5.10, 12.0.*, 12.1.*, 12.2.*). Please contact us to supply versions for
prior releases of Oracle.
If you encounter any problems or have any suggestions, please do not hesitate to
contact us at http://www.more4apps.com/request-technical-assistance/
Trial Version
The trial version of this program is fully functional and has no time-out. It does
however only upload 5 events at a time before stopping. To continue the upload you
must log in again.
The form and download options are not constrained in the trial version at all.

Disclaimer
This section is only relevant if you are on an Oracle Projects release prior to Family Pack
L.
There is no API prior to 11.5.9 PA.L for Events. We wrote our own API based on the
internal Oracle procedures. Accordingly, Oracle Support does NOT support use of this
program prior to P.A.L.
You are responsible for testing the product on your own data. We take no responsibility
for any damage whatsoever, as indicated by our end user licence agreement.

2. Overview – Steps to Loading Events
Once the Event Wizard has been installed for your instance of Oracle Applications, the
following steps outline the basic procedure for loading revenue and billing events using
Event Wizard.
Steps to load Events:
1. Open the Workbook, click on the ‘New Sheet’ button.
This can be found on the Event Wizard ribbon.

2. Login – Connect to your Oracle Applications instance.
Refer to section: Logging In and Out
3. Optionally, customize your set up.
This step is optional and only needs to be done once for a workbook.
Refer
Refer
Refer
Refer

to
to
to
to

section:
section:
section:
section:

Setup the Template
Customize Fields
Customize Your Lists of Values
Number Formats

4. Create/Update the Events.
Refer to section: Enter Events
Refer to section: Descriptive Flexfields
5. Upload the Events.
Refer to section: Upload Events
6. Correct errors after uploading the Events.
This step is only required if there are errors.
Refer to section: Error Handling and Validation
There are also several reference sections in this document for further information:


Getting Started



Profile Options



Ribbons



Toolbars



Trouble Shooting



Licence Keys, Named Users & Installation



Release Notes

3. Logging In and Out
This section is common to all of our tools.
Click on this link to navigate to Common User Instructions: Logging In and Out

4. Security
If you do not have access to the highlighted functions below in your selected
responsibility, you will be stopped from performing certain operations in Event Wizard.
Without the Project: Events function, you will not be allowed to submit an Event for
Import.

5. Setup the Template
This is standard functionality and to read more about making changes to ‘Template123’
refer to Common User Instructions: Customize the Template Sheet.
Refer to section: Customize Fields
Refer to section: Default Values

5.1 Customize Fields
To set optional fields to mandatory click on the ‘Customize Fields’ button on the Event
Wizard - Setup ribbon:

A form is displayed showing the list of optional fields that can be changed to
mandatory.
These fields can be made mandatory by checking the corresponding box:

Use this form to select the sections and columns that you would like to appear in your
specific worksheet.
A column can be made mandatory by checking the mandatory checkbox. This will make
this value compulsory when uploading the data into Oracle.
Click ‘Create Sheet’ button to create a new worksheet based on your selection.
Click ‘Cancel’ button to not save your selection but close the form.
Click ‘OK’ button to close the form.
To later create another worksheet based on the selection, simply open this form and
click on the ‘Create Sheet’ button again.
Default Values
Event Wizard provides you with the ability to enter default values in Row 10.
(Refer to section: Default Values)
Refer to section: Setup the Template

6. Enter Events
The Event Wizard allows the user to load Revenue and Billing Events into Oracle
Projects. You can type directly into the sheet or enter data into the Events Form.
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Methods of Entering Data into the Worksheet
Enter Events
Delete Events
Download Events
Upload Events
Default Values

6.1 Methods of Entering Data into the Worksheet
There are three ways to populate information in the worksheet:
a)

Import, type or paste data directly into the cells provided. No validation is
performed until you run the upload program or open the ‘Events’ form.

b)

Use the ‘Events’ form to enter the data into the event. Data is validated and lists of
values are available. To enter data in this way first position your cursor on the row
you wish to contain the event data. Then double-click in one of the cells or
alternatively click on the ribbon button.

c)

Use the ‘Download Events’ form or ‘Download from sheet’ option to download
existing events. You can then use one of the methods above to update the events
information.
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Enter Events
Delete Events
Download Events
Upload Events
Default Values

6.2 Enter Events
Position the cursor on the row you wish to enter the Event data (below row 10). Then
double-click in one of the cells that will contain the values. Alternatively click on the
‘Edit Events’ button. You can also enter data directly into the cells in the workbook or
copy and paste data in.

The following form will appear:
Event Tab

The following table describes how to enter specific information in the Event form fields:
Field Name

Description
The Project field is used to select the relevant Project Number
and Project Name.

Project

Enter a search string into the field using ‘%’ as the wildcard (it
will search across both Project Names and Project Numbers).
Click on the search button
. This will populate the dropdown list. Use the drop-down to select the correct project.
The Task field is used to select the relevant Task Number and
Task Name.

Task

Click on the search button
. This will populate the dropdown list with tasks for the selected project. Use the dropdown to select the correct task.

This step is optional - you do not have to associate an event
with a task (unless you change the workbook setup using the
‘Mandatory Fields’ button).
A number for the Event. This will automatically populate but
is updateable. The number should be unique for the Project
and Task.
Event Number

Event Numbers must be greater than 0 and cannot be
changed once the Event is billed or revenue generated.
This field is optional in Create mode. If left blank the upload
will generate the next available number for the combination of
Project and Task numbers.

Event Type

Select the Event Type from the list.
The date the Event is eligible for processing.

Event Date

This step is optional - you do not have to enter an Event Date
(unless you change the workbook setup using the ‘Customize
Fields’).

Adj Revenue
Flag

Check the ‘Adj Revenue’ check box if you are entering an
event to adjust revenue amount.

Rev Dist Flag

Indicates whether this Events revenue has been distributed.

Billed Flag

Indicates whether this Event has been billed.

The following table describes the purpose of each button in the Event tab on the form:
Button Name

Description

Ok

Selecting this button will close the form and the new values
will be written into the corresponding cells in the worksheet.
Any fields highlighted in red that have failed validation, will
not be written into the worksheet.

Cancel

Selecting this button will close the form and no changes will
be written into the corresponding cells in the worksheet.

Currency Tab
Use this form to enter your Multi-Currency information:

The following table describes the purpose of each field in the ‘Currency’ tab on the
form:
Field Name

Description
The Currency field is used to select the relevant
Currency. This field will default to the Projects
base currency (on upload) but if the Project is
Multi-Currency enabled, you can change it by
selecting a value from the drop list.

Currency
If you select a Project that is not Multi-Currency
enabled and you enter a different ‘Currency
Code’, a message ‘Project is Not Multicurrency
enabled’ will display in the ‘Upload Message’
column on exiting the form or on upload.
The following table describes the purpose of each button on the ‘Currency’ tab in the
form:

Button Name
Ok

Cancel
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Description
Selecting this button will close the form and the
new values will be written into the corresponding
cells in the worksheet.
Any fields highlighted in red have failed validation.
Selecting this button will close the form and no
changes will be written into the corresponding
cells in the worksheet.

Delete Events
Methods of Entering Data into the Worksheet
Download Events
Upload Events
Default Values

6.3 Delete Events
Event Wizard gives you the option to delete Events from the Oracle Project application.
Place the cursor on the row of the event you wish to delete and click on the ‘Delete’
button from the ribbon. It doesn’t matter what ‘Upload Option’ is selected.

‘Accepted’ will display in the ‘Upload Status’ column and the ‘Upload Message’ column
will populate with ‘Deleted Event’. All information for the Event will have been deleted
in Oracle Projects.
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6.4 Default Values
Row 10 of the Wizard is reserved for Default Values. Any data rows below Row10 will
be populated with default values if they are blank. This occurs when validation is
initiated on the worksheet and also when the data entry form is opened.

Any values that exist in the Default Values (Row10) where the column is hidden, will
default to your data entry rows.
Standard validation will apply if the defaulted value is not valid for the field.
Default data can be derived from either:
1. Any manually entered value

2. A formula i.e. =TODAY()

3. A Profile Option i.e PROFILE: <Profile Name>

Note: A PROFILE query must be prefixed with PROFILE: otherwise an error will be returned.
<Profile Name> is the profile name and not the 'User Profile Name' value. For example the profile: GL Ledger
ID has a profile name of 'GL_SET_OF_BKS_ID'
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7. Download Events
There are two options provided by the Event Wizard to download existing Events from
Oracle Projects. The information can subsequently be modified and reloaded.
Option 1: Download Using Form Based Selection Criteria
Place your cursor somewhere in the sheet below row 10. Data will be downloaded at
this point, pushing all existing rows downwards. Click on the ‘Download’ icon and select
‘Download Form’.

The following form will appear:

Enter criteria into one or more of the fields above, to select the relevant event.
Once the selection criteria have been entered into the relevant field(s), click on the
‘Download’ button. The events that meet the criteria will be extracted into the
worksheet.
Update these events by keying directly into the fields, or double-click on the transaction
to open the data-entry form.
Option 2: Download Using Spreadsheet Selection Criteria
As an alternative to the Download form, you have the option to download Events based
on data in the spreadsheet. This download method relies on the values specified in the
column. This option is currently limited to the following columns: Project Number,
Task Number, Event Number, Event Class, and Event Type.
Of course this can be
expanded, so please ask if you require additional columns in the selection criteria.

Note – When using the ‘Download from Sheet’ option in the Wizard, the ‘Default Values’
row (Row 10) is not used.
Enter the criteria for the download directly into the worksheet.

Select the rows to download and click the ‘Download’ button and select ‘Download from
sheet’, as shown below:

The results of the download are returned directly to the highlighted range.
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8. Upload Events
You first need to select on the ribbon the function that you need the Wizard to perform.
The choices are:
 ‘Validate only’ will perform validation on every populated field and set any
applicable default when an empty field is encountered. This allows the user to
perform a test run that validates the selected records but does not upload the
records.
 ‘Validate and Upload’ will perform validation as per the ‘Validate only’, but will
continue to load the records. Every validated transaction is sent to Oracle and an
Event Id is retrieved when successful.

There are three ways of selecting which Events will be uploaded (i.e. created or
updated):
-

A Single Event
A Range of Events
All Events on the Worksheet

Each method performs the same steps within the selection. Consequently, they only
differ by the scope of the selection. These three options are described in the following
sections:
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Upload a Single Event
Upload a Range of Events
Upload All Events
Error Handling and Validation

8.1 Upload a Single Event
Place your cursor anywhere on a row containing the Event you wish to upload. Choose
‘Validate only’ or ‘Validate and Upload’ from the ribbon.
Click the ‘Upload’ icon and select ‘Upload Selected’.

The event will be Updated/Created.
Refer to section: Upload a Range of Events
Refer to section: Upload All Events
Refer to section: Error Handling and Validation

8.2 Upload a Range of Events
Use the cursor to select your range of events to upload, making sure you have included
the first line of each event to be uploaded. Event Wizard looks through the spreadsheet
only between the top and bottom of the range you have indicated.
If you have selected a range and only included the first line of the last event to be
uploaded, Event Wizard will continue past the end of the selected range if necessary to
complete the last event. The columns selected are NOT important.
Choose ‘Validate only’ or ‘Validate and Upload’ from the ribbon. Click on the ‘Upload’
icon and select ‘Upload Selected’.

The selected events will be Updated/Created.
Refer to section: Upload a Single Event
Refer to section: Upload All Events
Refer to section: Error Handling and Validation

8.3 Upload All Events
Place your cursor anywhere in the sheet. Event Wizard ignores the cursor location and
goes straight to row 10 to begin uploading.
Choose ‘Validate only’ or ‘Validate and Upload’ from the ribbon.
icon and select ‘Upload All’.

Click on the ‘Upload’

This upload option ignores the cursor location and goes straight to row 10 to begin
uploading. It ignores any rows with ‘Accepted’ data.
Refer to section: Upload a Single Event
Refer to section: Upload a Range of Events
Refer to section: Error Handling and Validation

9. Error Handling and Validation
There are two levels of validation:
 Spreadsheet Validation - The Event form and Descriptive Flexfield form perform
some validation. This includes lists of values, some formatting rules and other
validation rules.
 Upload Validation - The upload process will perform the spreadsheet validation above
as well as the validation within the API.
Data keyed directly into the worksheet (not via the Event form) will be validated when
it is uploaded. If you wish to check anything before it is uploaded, simply open the
form.
Refer to section: Status and Message Columns
Refer to section: Correcting Errors and Reloading
Refer to section: Upload Events

9.1 Status and Message Columns
Every worksheet will be created with an ‘Upload Status’. The ‘Upload Status’ is used to
record the overall status for each Event. The ‘Upload Status’ may be:
 Blank – Prior to running the validate/upload process.
 Validated - When validation has been run and no errors are reported.
 Accepted – All the information for this event has been successfully loaded, updated
or deleted in Oracle Projects.
 Error - All the information for this event has not been successfully loaded into Oracle
Projects. Any incorrect data will appear in red in the worksheet cell and in the form.
In the following example one event has an error as the event type was not valid. All
other events were successfully processed.

Refer to section: Correcting Errors and Reloading
Refer to section: Upload Events

9.2 Correcting Errors and Reloading
Correcting Rejected Data
If you have an ‘Error’ status in the ‘Upload Status’ column, look for the cell that is
highlighted red and investigate and correct the data.
To correct the information either key directly into the worksheet, or open the Event
Form.
Once the data has been corrected you can choose to either upload one row, selected
rows or the entire worksheet.
Refer to section: Upload Events
Events that already have an Upload Status of ‘Accepted’ will not be processed again.
Continuing the previous example after correcting the data and rerunning the upload
process will show all records are successfully transferred into Oracle Projects.

Refer to section: Status and Message Columns
Refer to section: Upload Events

10. Ribbons
There are two ribbons for Event Wizard:


Event Wizard - Setup Ribbon is used to help set up the Wizard.



Event Wizard Ribbon is used to carry out functions when working in your
workbook.

The menus are also available using the right mouse click functionality within Excel. If you
press the right mouse button you will see the Event Wizard ribbon options.

Refer to section: Event Wizard - Setup Ribbon
Refer to section: Event Wizard Ribbon

10.1 Event Wizard - Setup Ribbon
The following table provides a quick reference to the Event Wizard – Setup Ribbon and
its functions.
Excel 2007 and Later

Icon

Setup Visibility

Description/Functionality

Once your set-up is done you may not want your users to
change the set-up so you can hide the setup ribbon.
There are three options:
 Show at Start-up – The setup menu always appears.
 Hide at Start-up – The setup menu is hidden but can be
found using:
View -> Macros -> Show_Event_Wizard_Toolbars ->
and then click ‘Run’
 Hide Permanently – The setup menu is hidden and cannot
be displayed. Revert back to a copy of the original workbook
to display the menu.

Login Method

Choose one of three methods for logging in:
 Standard Login – This will use single sign-on where
available.
 Alternative Login – This will use application level sign-on.
 Standard Login (SSO Bypass) – This will use single-signon Bypass. This login method is available from Oracle EBS
11.5.9 onwards and can be used if you have SSO installed
but want to bypass the SSO mechanism. The user will be
authenticated to the internal FND_USERS table rather than
the external SSO.

Debug Upload

For the 4x ‘Debug Upload’ options mentioned below, the user will
be under instruction from More4Apps Support (used for Support
purposes only). The default value is ‘Debug off’ unless
instructed by More4Apps to change:


Debug Mode – Turns on the More4Apps debug facility to
generate debug messages to assist with product
troubleshooting.



DB Trace mode – Generates a database trace for database
Version 9i.



End to End Trace – Database trace generated for
performance analysis and product troubleshooting.



Debug Off – Disables any of the above options that are
enabled.

Edit Template

Show or Hide Template worksheet. If you modify the template
worksheet, subsequent worksheets created using the ‘New
Sheet’ icon will be based on this template.

Customize LOVs

This button will open a form to allow you to customize your list
of values.

Customize Fields

The customize fields option allows you to make optional fields
mandatory.

Number Format

Record the format of the current cell to use numeric values for
the Amount/Quantity columns in the Wizard. You need to save
the spreadsheet to keep the setting.

Store Password

You can protect your worksheet after data-entry to prevent
further changes. However, you must store the password in
order to use the upload/validate functions.

Click on this icon and store the password that you have used to
protect the worksheet.
For further information refer to
Common User Instructions: Worksheet Protection

Export URL

Export Login Configuration Settings to New Sheet.
The login configuration allows you to store links to multiple
instances of Oracle Applications. Create a new blank sheet
(insert worksheet) and click on this icon. The current login
configuration will be copied into cell A1. This can then be copied
into another workbook (into cell A1) and imported using the
option below.

Import URL

Import Login Configuration Setting from Current Sheet.
The login configuration that has been copied into cell A1 of the
current sheet will be used to set up the list of instances available
in this workbook.

Refer to section: Event Wizard Ribbon

10.2 Event Wizard Ribbon
The following table provides a quick reference to the Event Wizard Ribbon and its
functions.
Excel 2007 and Later

Icon

Description/Functionality

Log In/Log Out

This will either log you into or out of EBS depending on your
status (terminate or reinstate your Oracle database connection).
The icon will change depending on your current status. If you
are currently logged in then the icon will show as ‘Log Out’. If
you are not logged in the icon will show as ‘Log In’.

About

Displays version and licencing information.
You need to click on this icon to load a new licence key or modify
the list of named users.

Show/Hide Login Info

This button toggles the display of the ‘Login Info’ information on
the ribbon.

New Sheet

A new worksheet will be created based on the master template
sheet.
If you have not modified the master template (using the
‘Show/Hide Template’ icon above) all columns available will be
displayed. If you have modified the master template, your new
worksheets will include these changes.

Edit Events

A form to enter the event information will display. If you do use
this form, you can make use of the ‘Lists of Values’ and other
validation as you are entering data.
Double click in the worksheet below row 9 will give same result.

Edit DFF

A form will open to enable the flexfield information to be entered
against the fields. You do not have to use this form, you can
copy and paste or key directly into the fields if you prefer.

Delete

This button will enable you to delete selected events from Oracle
Projects.

Validate Option

Choose whether to ‘Validate and Upload’ or ‘Validate only’ when
uploading lines into Projects.
This selection is used in conjunction with the ‘Upload Selected’
rows icon and the ‘Upload All’ rows icon (below).

Upload Option

Choose whether to ‘Create Events’, ‘Update Events’ or ‘Create
and Update Events’ when uploading lines into Projects.
This selection is used in conjunction with the ‘Upload Selected
Rows’ icon and the ‘Upload all rows’ icon (Below).
Note the following when using:
Update Events – Using ‘Update Events’ an Event without
Currency information on the sheet, the user will receive an error
‘Currency Code field must not be null when updating Events’.
Create and Update Events – Using ‘Create and Update Events’
and updating an Event without Currency information on the
sheet, the Event will upload successfully as there’s an extra
validation step in the process and it picks up the base currency
in that validation step.
This icon excludes ‘AUTOMATIC’ Events from the ‘Download from
Sheet’.
This icon enables you to remove status column information from
the worksheet.

Upload Selected

The selected rows (as indicated by
validated/loaded into the interface table.

the

cursor)

will

be

Upload All

All rows in the worksheet (that have not already been processed)
will be validated/loaded into the application.

Download Form

A form will open that will enable you to choose event information
from Oracle and populate into the worksheet.

Download from Sheet

Download data based on data in the spreadsheet. This download
relies on the values specified in the column.

Refer to section: Event Wizard - Setup Ribbon

11. Getting Started
This section provides a new user with tips on how to get started using the Event Wizard.
1. Enable Macros – The worksheet requires the macros to be enabled.
Microsoft 2007 or Later – When the worksheet is first opened on the menu bar
the following will appear. Click on the ‘Enable Content’ button.

Microsoft 2003 – When the worksheet is first opened the following message will
appear. Click ‘Enable Macros’.

2. Unable to see Wizard Ribbons/Toolbars - If this occurs then your security
settings are too high. Event Wizard is written in VBA, and you must allow macros to
run before you can run the program. Close the worksheet then from the Excel menu
navigate to the following based on your version of Microsoft:
Microsoft 2007 or Later - Navigate to the ‘Developer’ tab, in the ‘Code’ group,
click ‘Macro Security’. In ‘Macro Settings’, select the ‘Disable all macros with
notification’. Reopen the worksheet and you will receive the message shown
above.
Microsoft 2003 – Navigate to Tools> Macro> Security> Security Level and
set to Medium level. Reopen the worksheet and you will receive the message
shown above.
Note: If the Developer tab did not display, click the Microsoft Office button
,
then click ‘Excel Options’ button. In the ‘Popular’ category, select ‘Show Developer
tab on the Ribbon’. You should now be able to go back to the Developer Tab to
make the security changes.
Refer to section: Enable Macros/Cannot Access Wizard Ribbons

3. Wizard Ribbons/Toolbars – Please see the note below for details on the
ribbons/toolbars provided by the Wizard.
Refer to section: Ribbons
Refer to section: Toolbars
4. Trial Version - If you are using the trial version it will log you out after 5 records
have been uploaded. You will need to log in again to continue. There are no other
constraints in the trial version.
5. Row 9 - The column names are stored in row 9. This is fixed and cannot be
changed. Do NOT insert or delete rows before row 10. The case of the names is not
important but spelling is. If you change the contents of row 9 in any column, you
have in effect deleted the column as far as the program is concerned. You can move
the columns anywhere you like, hide, or even delete them.
6. Row 10 - This row is used to enter Default Values. Any data here will be defaulted
into the same record where no data exists in the worksheet.
7. Populate the Worksheet - There are a number of options available to populate the
worksheet:
 Type or paste the relevant values directly into the worksheet (No validation is
performed until you run the upload program).
 Use the data entry forms provided to enter and validate the values.
 Download existing data and modify the information to update the record, OR
 Download existing data and use this as the starting point to create new records.
Note - If you are downloading an existing record to create a new one you need to
remove the IDs of the existing records.
Refer to section: Enter Events
8. Descriptive Flexfields (DFF’s) - In this Wizard only a couple of attribute flexfield
columns are displayed in order to reduce unnecessary clutter. For help on using
DFF’s please refer to the online documentation.
Refer to section: Descriptive Flexfields
9. Trouble Shooting - If you are having any problems using the Wizard, click on this
link to search our online solutions repository
http://www.more4apps.com/Support/Solutions.html
If you encounter any problems or have any suggestions, please do not hesitate to
contact us at http://www.more4apps.com/request-technical-assistance/

12. Number Format

This section is common to all of our tools.
Click on this link to navigate to Common User Instructions: Numeric Format

13. Customize Your Lists of Values
This section is common to all of our tools.
Click on this link to navigate to Common User Instructions: Customize your List of
Values

14. Descriptive Flexfields (DFF’s)
Event Wizard allows you to upload and download Descriptive Flexfield information.
The flexfield icon is available on the product ribbon (as per screenshot below) or when
double clicking in the applicable DFF section on the sheet.

The following ‘EventsDFF’ form will open.
form.

Update the DFF information by using this

This functionality is common to all our tools.
Click on this link to navigate to Common User Instructions: Descriptive Flexfields

15. Profile Options
Profile Options are common to all of our tools. To find the profile options applicable for
this Wizard, navigate to System Profile and enter More% EW % (Note the space
before EW) as shown in the screenshot below, and select the ‘Find’ button.

The profile option applicable for this Wizard will show on the ‘System Profile Values’
form as shown below.

Many profile options can be set at the Site, Application, Responsibility or User level.
Modify your search in the ‘Find System Profile Options’ form to set options at the
appropriate level.

Profile Options are installed when you log into an instance (from the Wizard) for the
first time. If a profile option is not available then you will need to re install your profile
options. To do this refer to the Re Install Profile Options available in the Common User
Topics documentation.
Common Profile Options
The following profile options are created for each of our products:


More4Apps: EW Licence Key - This profile holds the licence key for the Wizard.
If you have no license key then this field will hold ‘Trial’ as the licence key and
some functionality will be limited. For more details on licence keys refer to the
following Installation and Configuration Guide: Enter the Licence Key.



More4Apps: EW Load Counter - This profile is used when the Wizard is in trial
mode and counts the number of transactions completed before the Wizard logs
out of your Oracle instance. This functionality will be obsolete as Wizards are
upgraded.



More4Apps: EW Named User - This profile enables you to control the named
users for Project Wizard and is set at the User level in Oracle. For more details
on how to set up named users refer to the following Installation and
Configuration Guide: Add Named Users.



More4Apps: EW Minimum version – This option allows you to enter the
spreadsheet version number into this profile option. If the spreadsheet version
does not match this then the wizard will not operate.



More4Apps: EW Banned – If this profile option is set to ‘Yes’ the Wizard will not
operate. This can be set at the site, responsibility or user level.



More4Apps: EW Automatically Assign User – If this is set to ‘Yes’ Oracle will
assign new users automatically up the maximum allowed by the licence key.



More4Apps: EW Allowed version – This profile option is similar to ‘More4Apps:
EW Minimum version’ but is more restrictive. It will stop any version other than
the listed version from operating.



More4Apps: EW Latest Version Used - This profile option is for internal use only.
It records the highest version number used.



More4Apps: EW Limit to preset Application ID – Set this profile to ‘Yes’ to limit
the selection of user responsibilities to those assigned to the same application as
the Wizard or set to ‘No’ or leave blank to display all responsibilities assigned to
the user.



More4Apps: EW Nominated Sysadmin for user maintenance – This profile can be
set to allow a nominated person who doesn't have System Administrator profile
value access to maintain users for this product. Other users that do have System
Administrator profile access can still maintain product users if this profile is set
to a different person.

Note – This profile option is only available for clients with Wizard versions
containing ‘Common Modules’ version 205 and greater.


More4Apps: EW Unicode Encoding Option - This profile determines if character
sets used by different applications are converted. By default this is set to
‘Automatic’ and should not be changed unless advised by More4Apps Support.



More4Apps: EW Allow MS-Word autocorrect characters - This profile can be set
to prevent MS-Word AutoCorrect characters (which are non-ASCII) from being
loaded – If these are loaded it can cause data corruption.

Product Specific Profile Options
The following profile options are specific to Event Wizard:


More4Apps: EW Validate Only - This profile can be set to ‘Yes’ to allow the
customer to setup validate only for the user.

16. Toolbars
There are two toolbars for Event Wizard:


Event Wizard - Setup Toolbar is used to help set up the Wizard.



Event Wizard Toolbar is used to carry out functions when working in your
workbook.

Refer to section: Event Wizard - Setup Toolbar
Refer to section: Event Wizard Toolbar

16.1 Event Wizard - Setup Toolbar
The following table provides a quick reference to the Event Wizard - Setup Toolbar and
its functions.
Excel 2003

Icon

Description/Functionality

Show/Hide Toolbar

Once your set-up is done you may not want your users to
change the set-up so you can hide the setup toolbar.
There are three options:
 Show at Start-up – The setup menu always appears.
 Hide at Start-up – The setup menu is hidden but can be
found using:
View->Toolbars -> Event Wizard - Setup.
 Hide Permanently – The setup menu is hidden and cannot
be displayed.
Revert back to a copy of the original
workbook to display the menu.

Login Method

Choose one of three methods for logging in:
 Standard Login – Will use single sign-on where available.
 Alternative Login – Will use application level sign-on.
 Standard Login (SSO Bypass) – This will use single-signon Bypass. This login method is available from Oracle EBS
11.5.9 onwards and can be used if you have SSO installed
but want to bypass the SSO mechanism. The user will be
authenticated to the internal FND_USERS table rather than
the external SSO.

Edit Template sheet

Show or Hide Template worksheet. If you modify the template
worksheet, subsequent worksheets created using the ‘New
Sheet’ button will be based on this template.

Customize Fields

Store Password for
Worksheet Protection

The customize fields option allows you to make optional fields
mandatory.

You can protect your worksheet after data-entry to prevent
further changes. However, you must store the password in
order to use the upload/validate functions.
Click on this icon and store the password that you have used to
protect the worksheet.
For further information refer to
Common User Instructions: Worksheet Protection

Customize your List of
Values

This button will open a form to allow you to customize your list
of values.

Record Format of Cell

Record the format of the current cell to use numeric values for
the Amount/Quantity columns in the Wizard. You need to save
the spreadsheet to keep the setting.

Export Login Config

Export Login Configuration Settings to New Sheet.
The login configuration allows you to store links to multiple
instances of Oracle Applications. Create a new blank sheet
(insert worksheet) and click on this icon. The current login
configuration will be copied into cell A1. This can then be
copied into another workbook (into cell A1) and imported using
the option below.

Import Login Config

Import Login Configuration Setting from Current Sheet.
The login configuration that has been copied into cell A1 of the
current sheet will be used to set up the list of instances
available in this workbook.

Refer to section: Event Wizard Toolbar

16.2 Event Wizard Toolbar
The following table provides a quick reference to the Event Wizard Toolbar and its
functions.
Excel 2003

Icon
Log In/Out

Description/Functionality
This will either log you into or out of EBS depending on your
status (terminate or reinstate your Oracle database
connection).
The icon will change depending on your current status. If you
are currently logged in then the icon will show as ‘Log Out’. If
you are not logged in the icon will show as ‘Log In’.

About this Program

Displays version and licencing information.
You need to click on this icon to load a new licence key or
modify the list of named users.

New Sheet

A new worksheet will be created based on the master template
sheet.
If you have not modified the master template (using the
‘Show/Hide Template’ icon above) all columns available will be
displayed. If you have modified the master template, your new
worksheets will include these changes.

Events Form

A form to enter the event information will display. If you do
use this form, you can make use the ‘Lists of Values’ and other
validation as you are entering data.
Double clicking in the worksheet below row 9 will give same
result.

Descriptive Flexfields

A form will open to enable the flexfield information to be
entered against the fields. You do not have to use this form,
you can copy and paste or key directly into the fields if you
prefer.

Delete Event indicated
by cursor position

This button will enable you to delete selected events from
Oracle Projects.

Validate options

Choose whether to ‘Validate only’ or ‘Validate and Upload’ when
uploading lines into Projects.
This selection is used in conjunction with the ‘Upload Selected’
rows icon and the ‘Upload All’ rows icon (below).

Upload options

Choose whether to ‘Create Events’, ‘Update Events’ or ‘Create
and Update Events’ when uploading lines into Projects.
This selection is used in conjunction with the ‘Upload Selected
Rows’ icon and the ‘Upload all rows’ icon (Below).
Note the following when using:
Update Events – Using ‘Update Events’ an Event without
Currency information on the sheet, the user will receive an
error ‘Currency Code field must not be null when updating
Events’.
Create and Update Events – Using ‘Create and Update
Events’ and updating an Event without Currency information on
the sheet, the Event will upload successfully as there’s an extra
validation step in the process and it picks up the base currency
in that validation step.

Clear Status Column

This icon enables you to remove status column information
from the worksheet.

Upload selected rows

The selected rows (as indicated by the cursor) will be
validated/loaded into the interface table.

Upload all Events on

All rows in the worksheet (that have not already been

Sheet

Download Data

processed) will be validated/loaded into the application.

A form will open that will enable you to download event
information into the worksheet.

Refer to section: Setup Toolbar

17. Trouble Shooting
If you are having any problems using the Wizard, click on this link to search our online
solutions repository http://www.more4apps.com/Support/Solutions.html
If you are unable to find a solution or have any suggestions, please contact us at
http://www.more4apps.com/request-technical-assistance/

18. Licence Keys, Named Users & Installation
The instructions for product installation, setting up the list of instances, using licence
keys and adding named users are in the Installation and Configuration Guide.

19. Release Notes
Click on this link to navigate to the EW Release Notes
This link is also available from the Product Page on the website.
This user documentation is based on EW Release Version 5.4.20

